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Introduction 
  
Thank you for purchasing the West Mountain Radio CBA II, We think you will find it takes the guesswork out
of using batteries. 
  
The CBA is much more than a simple battery voltage tester or a battery load tester.  Unlike a simple load 
tester the CBA will test virtually any type or size of battery, any chemistry or number of cells, up to 48 volts.  
For the first time and for a reasonable price, anyone can do scientific tests of their batteries. 
  
The CBA is capable of much higher test rates than other testers; up to 40 amps or 150 watts, whichever is
higher.   
  
The CBA not only tests the total amount of energy stored in a battery (capacity in amp-hrs) but it graphically 
displays and charts the voltage versus time using a constant current load.  The graphs may be displayed, 
saved and printed.  Multiple test graphs of the same battery, or multiple batteries, may be compared or 
overlaid, a very useful feature.  The battery test data can be printed on a color or black and white printer.  
You may also print convenient test labels to put directly on your batteries.  The CBA will test the temperature 
of a battery with the optional external temperature probe and provide automatic over temperature test cutoff.
  
It is ruggedly built and is supplied with 13-gauge high-grade wire with Powerpole connectors for the battery
connection.  It is small and has a high performance cooling system with a quiet fan. LED indicators, visible 
from across a room, display communication and test status, . 
  
The CBA II uses an 8051 based microcontroller to measure voltage, current and temperature with high
accuracy.  Each CBA is individually calibrated with an automated test system. It has 10 bit resolution in three
auto-switched voltage ranges. The current is set with 12 bit resolution below three amps and it is measured
with 10 bit above three Amps.   
  
The electronic load uses a PWM-controlled power MOS FET with electronic current regulation and software
feedback control.  The microcontroller provides an integrated plug-and-play USB interface to the computer 
  
The software, supplied with the CBA, is easy to use and intuitive. It provides automatic sensing of the 
battery cell count, a safety check of the test rate, and recommends a minimum safe discharge voltage.  It is 
designed to protect both the CBA and the batteries that you are testing. 
  
We hope that you enjoy using the CBA and find it useful.  You will learn valuable information about the 
batteries that you test. 
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Safety Precautions 
  
The West Mountain Radio CBA is inherently safe but the batteries it tests are not.  Anything that stores 
energy is potentially dangerous!  A can of gasoline can be safe if treated properly but imagine what can 
happen.  Some types of batteries are safer than others but they are all capable of causing explosions or 
fires. 
  
Primary safety considerations: 
  

Never discharge a battery at a higher discharge rate than it is designed for. 
  

Never use a battery that has poorly insulated or frayed wiring or exposed metal parts. 
  

Never connect a battery with reverse polarity. 
  

Never test a battery near flammable materials. 
  

Never allow a battery reach a temperature that causes it to get so hot that it may be too hot to touch. 
  

Never test or charge your batteries while unattended. 
  

Have a fire extinguisher nearby. 
  
CBA operating requirements: 
  

Never connect a battery with the polarity reversed! 
  

Always connect the USB cable BEFORE connecting the battery! 
  

Operate the CBA in a cool dry location. 
  

Never allow metal parts or wiring of the battery come in contact with the metal heat sink. 
  
Never allow the cooling fan to be blocked or jammed. 
  
Do not ignore the warnings that our software may give you. 
  
The CBA can get hot. Do not touch the metal heat sink while, or shortly after, conducting a high 
power test. 

  
Lead acid battery safety warnings: 
  
There may not be a consideration while testing lead acid batteries but there certainly is while charging lead
acid batteries.  These batteries, especially automotive and marine types, give off explosive hydrogen gas
when charged.  A nearby or internal spark or flame can cause a lead acid battery to explode sending liquid
acid and lead shrapnel in all directions.  This is particularly dangerous and frequently causes blindness or 
severe scarring injuries. 
  
Never use a standard lead acid battery without proper ventilation.  Sealed lead acid batteries such as gelled 
or AGM (absorbed glass mat) types are much safer. Automotive and marine types are not safe and should



be used in protective ventilated housings, such as under the hood of a car. 
  
Never make the last connection to a lead acid battery causing a spark on the terminal.  Always connect the 
load or charger last, and at a safe distance away from the battery. 
  
NiCad, NiMh, and Alkaline safety warnings: 
  
These batteries can be dangerous also.  If they are shorted out, or charged or discharged at too high a rate,
they can overheat and explode.  A single D size NiCad cell can actually melt a 10 penny nail, don’t try this! 

   
Lithium safety warnings: 
Reprinted with permission of the Academy of Model Aeronautics 
Words in () in red were added by West Mountain Radio 
  
Lithium Battery Fires 
Lithium batteries are becoming very popular for powering the control and power systems in our models. This is true because of
their very high energy density (amp-hrs/wt. ratio) compared to NiCads or other batteries. With high energy comes increased risk in
their use. The, principal, risk is FIRE which can result from improper charging, crash damage, or shorting the batteries. All vendors
of these batteries warn their customers of this danger and recommend extreme caution in their use. In spite of this many fires 
have occurred as a result of the use of Lithium Polymer batteries, resulting in loss of models, automobiles, and other property.
Homes and garages and workshops have also burned. A lithium battery fire is very hot (several thousand degrees) and is an 
excellent initiator for ancillary (resulting) fires. Fire occurs due to contact between Lithium and oxygen in the air. It does not need 
any other source of ignition, or fuel to start, and burns almost explosively. 
  
These batteries must be used in a manner that precludes ancillary fire. The following is recommended: 
  
1. Store, and charge (discharge), in a fireproof container; never in your model. 
  
2. Charge (discharge), in a protected area devoid of combustibles. Always stand watch over the 
charging (discharging), process. Never leave the charging process unattended. 
  
3. In the event of damage from crashes, etc, carefully remove to a safe place for at least a half hour to observe. Physically
damaged cells could erupt into flame, and, after sufficient time to ensure safety, should be discarded in accordance with the
instructions which came with the batteries. Never attempt to charge (discharge) a cell with physical damage, regardless of 
how slight. 
  
4. Always use chargers designed for the specific purpose, preferably having a fixed setting for your particular pack. Many fires 
occur in using selectable/adjustable chargers improperly set. Never attempt to charge Lithium cells with a charger which is not,
specifically, designed for charging Lithium cells. Never use chargers designed for Nickel Cadmium batteries. 
  
5. Use charging systems that monitor and control the charge state of each cell in the pack. Unbalanced cells can lead to disaster if
it permits overcharge of a single cell in the pack. If the batteries show any sign of swelling, discontinue charging, and remove 
them to a safe place outside as they could erupt into flames. 
  
6. Most important: NEVER PLUG IN A BATTERY AND LEAVE IT TO CHARGE (DISCHARGE), UNATTENDED OVERNIGHT. 
Serious fires have resulted from this practice. 
  
7. Do not attempt to make your own battery packs from individual cells.  These batteries CANNOT be handled and charged 
casually such as has been the practice for years with other types of batteries. The consequence of this practice can be very
serious resulting in major property damage and/ or personal harm. 
  
Again: 
  
Primary safety considerations: 
  

Never discharge a battery at a higher discharge rate than it is designed for. 
  

Never use a battery that has poorly insulated or frayed wiring or exposed metal parts. 
  

Never connect a battery with reverse polarity.



  
Never test a battery near flammable materials. 

  
Never allow a battery reach a temperature that causes it to get so hot that it may be too hot to touch. 

  
Never test or charge your batteries while unattended. 

  
Have a fire extinguisher nearby.  
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Getting Started 

We highly suggest that you read our entire help for a full understanding of the CBA! 
  
1. From the CD ROM opening screen click on “Software and Hardware Installation”.  Follow the instructions 
on the screen to complete both the hardware and software installations. 
  
2.  Connect the CBA to your computer’s USB port using the supplied cable before connecting a battery. 
Note: If Windows says: “Found new Hardware”, you did not complete the previous step. 

3.  Start the West Mountain Radio CBA program by clicking on the icon:   
Note: The CBA’s green LED should come on and the program will display “Stopped" in green letters. 
  
4.  Before a new test you must type a name in the “Test Name” window that lets you identify the test.  You 
should use a name that describes the battery and what it is used in. Tip: We suggest that you label or number your 
batteries and refer to them, and their tests, by their number. If you forget to type in a test name the program will remind you to 
supply a name before allowing you to start a test Note: the ”Test Name” is not same as the file name that a test or group of tests 
may later be saved under. 
  
5.  Select the correct “Battery Type” (chemistry) if that type is not already selected. 
  
6.  Select the rated “Capacity” for the battery you would like to test.  For example if it is a battery rated at 600 
mA-h select .6 A-h (in amperes), not mA. 
  
7.  Connect the battery.  WARNING: YOU MUST CONNECT THE CBA'S USB CABLE BEFORE 
CONNECTING A BATTERY! BE CERTAIN THAT YOU HAVE THE POLARITY CORRECT! RED TO RED, 
BLACK TO BLACK AND PLUS TO PLUS, MINUS TO MINUS! 
  
8.  The battery voltage display will come up indicating the resting battery voltage.  You will see the program 
make an estimate of the number of cells.  If you find that the number of cells is incorrect, correct the cell 
count or battery type. 
  
9.  Choose the discharge current for the test that you would like to run in the “Test Amps” window.   
CAUTION: DO NOT CHOOSE A HIGHER DISCHARGE RATE THAN THE BATTERY IS CAPABLE OF.  
SEE THE BATTERY MANUFACTURE’S SPECS.  Note: If the no load battery “Voltage” multiplied times the “Test 
Amps” selected (Volts times Amps = Watts) exceeds the wattage rating of the CBA, or our default recommended maximum 
discharge rate limits, you will be prompted to lower the discharge current before continuing.  The CBA will run tests at up to 150 
watts with a battery that has a rated capacity of 1 Amp-Hr or less, up to 125 watts below 3.5 Amp-Hrs and 100 watts for any 
capacity battery.  If the test current could be too high for the capacity rating and type of battery, you will get a warning prompt. You 
may over-ride the warning recommendation at your own risk.  
  
10. Press the green start button.  If you have all the settings correct you will see the graph start to appear 
and auto-scale, the measurement readings windows will change from green to red, the red LED will come 
on, and the green word “Stopped” will change to a red “Running” and the fan will start.  The current display 
will come up to the test level, the wattage will be displayed and the Amp hours will start to accumulate as the 
graph trace appears. 
  
11. The test will continue until the “Test Cutoff V” is reached.  At that point the test will automatically stop 
and the program will display “Test Complete”.  Everything will return to the stopped condition ready to take 
your input for your next test.  Disconnect the battery at this time.  CAUTION:  The battery and the CBA may 
be HOT! 
  
12.  When the test is complete you may go to the “File” menu and save or print the file or run another test.  



Note: If you close the program or try to run another test you will be asked if you wish to save the completed test already on the 
screen. 
  
13.  If you wish to run another test, start at step 4 of these instructions.  Upon starting another test you will 
be given three choices:  to discard the previous test, save and start a new test or add the new test to the 
previous one.  Choose the appropriate choice and the new test will start immediately.  
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The CBA program 
  
The basic operation is covered in the “Getting Started” section of our manual / help documents.  This section 
gives a more detailed explanation of using the program and it’s features.  
  
Main Screen, Test Settings: 
  
To start a new test you must first type in a “Test Name”. Choose a name that makes it easy to identify the 
battery that was tested.  Tip: When completed and the file is saved, the program will save that test, with the name, along with
other information, such as; test rate, date, time and voltages.  A file may be saved under another or different name, as necessary, 
when there are multiple tests saved together in one file. 
  

 
  
Next, select the “Battery Type” (Chemistry), and the rated capacity in A-h (to convert mA-h to A-h divide by 
1000).   
  
Connect the battery: the CBA will measure the no load voltage and the program will estimate the number of
cells.   
  
The program will automatically recommend the “Test Amps” discharge rate, and a safe “Test Cutoff V”.  This 
is based on the battery type and capacity that you typed in and on the measured voltage.  Tip: You may 
optionally change the discharge rate, “Test Amps” or cutoff Voltage, however the program will “ask you if you are sure” if you 
choose higher discharge rate or a lower cutoff voltage before allowing you to start the test.   
  
Make sure that all the information, displayed across the top of the screen, is correct.  If necessary, fix the 
entries, before starting the test. 
  
Press one of the green “Start” buttons to start the test. 
  
  
  
  
  
Main Screen, Test Readings: 
  
After starting a test you will see the current increase to the "Test Amps" level that you have 
chosen. The A-h will begin to accumulate and the "Watts" will be displayed.  The green 
background will change to red, the word in green, “stopped”, will change to a red 
“RUNNING” and the CBA fan will come on.  The graph of voltage versus A-h will start to 
display on the screen.The green start buttons will change to red stop buttons. 
  
If you have the optional temperature probe connected and calibrated, the CBA will display 
temperature.  
  
  



  
  
  
File Menu: 
  
After the completion of a test you may select “File”, “Save” and save the file under 
the same or different name than the previously chosen test name.  
  
The file menu has a special “Overlay” choice so that test comparisons may be 
made.  With a test already on open on the screen you may add additional tests to 
the same display for battery comparison purposes by using the “Overlay” choice.  
Overlay opens files that have been saved with one or more tests in them and 
overlays those tests on top of the test screen that is already there.  This is very 
useful for comparing test results with the same battery over time or with different 
batteries. 
  
There is a “Export” function to export a test or multiple tests in the standard .CSV 
(Comma Separated Values) to be imported in to another program such as 
Microsoft Excel. This file export to a spreadsheet program such as Excel will allow 
you to analyze the data in whatever way you choose.  
  
There is a recently opened file list towards the bottom of the “File” menu, for your 
convenience, to recall those recent files.  The other “File” menu choices are standard with most Windows
programs and work as you would expect. 
   
If you try to run another test with a previous test on the screen you 
will be given a pop-up file menu with several options as shown.  Be 
sure to select the appropriate option. 
  
  
  
  
  
  
  
  
Edit Menu: 
  
From the “Edit” menu standard Windows edit 
functions are grayed out and disabled but you may 
access “Preferences...”, “Calibrate Temp Probe...” 
and “Lab Calibrate”  
  
Click on “Preferences...” to select your choice of 
temperature in Degrees F. or C. for display with the 
optional temperature probe. 

From “Preferences...” there is an option check box that, by default, causes the program to remember its
window size and position, the next time the program is started. 

From “Preferences...” there is an option check box to enable automatic test over-temperature cutoff when 
the optional temperature probe senses the selected or default temperature limit being reached. Do not check
this box if you do not have a temperature probe connected and calibrated. 

From “Preferences...” there is an option check box to select only black and white graph printing. Use this 
option if you wish only black and white graph printing. 


